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Abstract 

Flood mitigation measures have become a contentious challenge due to the lack of 

infrastructure to prevent them after the 10 October 2017 flash floods, which impacted the 

Isipingo and Umlazi area the hardest within the eThekwini Municipality. The storm which 

caused the damage were measured as a 1 in 100 year recurrence interval storm or greater, 

however eThekwini Municipality only caters for 1 in 3 year storms and 1 in 10 year storms at 

critical points. A capital injection would thus be required to cater for a 1 in 100 year recurrence 

interval storm amidst a precarious economic climate. The purpose of this study is to determine 

a cost effectiveness analysis of conventional stormwater management systems, Sustainable 

Urban Drainage Systems (SUDS) and an attenuation facilities based stormwater management 

system as alternative configurations for the Isipingo Prospection area. A cost effectiveness 

analysis will be deduced by means of a multi-criteria decision matrix which enables a holistic 

incorporation of environmental and social effectiveness of the stormwater management 

systems proposed instead of costs in isolation. In addition, this approach allows for 

sustainability and an objective inclusion of preservation of biodiversity, social wellness and 

comparison of alternatives without compromising the functionality of the stormwater 

management system. The results show that Sustainable Urban Drainage Systems is the most 

cost-effective due to the utility of green infrastructure as opposed to a high reliance on grey 

infrastructure, with a final weighted score of 4.12 and Bill of Quantities (BOQ) estimate of 

R2 119 047.50, which is highly influenced by the excellent performance in the cost-

effectiveness criteria. In addition, green infrastructure is able to incorporate environmental and 

social effectiveness and lower the costs required for mitigating a 1 in 100 year recurrence 

interval storm in the catchment studied. Conventional stormwater management systems 

received a final score of 2.22, which reflects the low cost and environmental effectiveness 

performance of 2.2 and 2 respectively. The BOQ estimate amounted to R5 188 921.33. 

Attenuation facilities based configuration was the least cost effective with a final score of 1.8, 

due mainly to the cost required for the underground concrete attenuation facility at a BOQ 

estimate value of R16 007 209.38. The utility of a multi-criteria decision matrix as a means of 

conducting a cost effectiveness analysis comes highly recommended by this study as an 

objective decision making tool for project managers. The alignment of existing strategies and 

policies requires the filtration to project managers to include green infrastructure to enable 

integration and sustainability.  
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1. Chapter One: Introduction 

1.1 Background of Study 

Subsequent to the severe storms which flooded eThekwini Municipality in June 2016 and October 

2017 the Coastal, Stormwater and Catchment Management (CSCM) department within eThekwini 

Municipality was mandated to assist in flood mitigation measures. The Isipingo and neighbouring 

Umlazi area, in the Southern region of eThekwini was one of the areas which were heavily distressed 

by the storms which are estimated to be having been greater than or equal to 1 in 100 year recurrence 

interval storms. Stormwater infrastructure which is collapsed, damaged and/ or blocked due to the 

floods thus caused a negative externality on the community. 

eThekwini Municipality caters for 1 in 3 year recurrence interval storms and 1 in 10 recurrence 

intervals at critical points such as low points and road crossings (Stormwater Guideline, 2012). The 

integrity of infrastructure is the responsibility of the government, thus municipalities are required 

to create an environment which is safe and conducive for productivity. Furthermore, prioritising 

infrastructure development is also aligned with eThekwini Municipality’s vision “To become the 

most liveable city by 2030” (eThekwini Municipality, 2019).  

The economic implications of upgrading the existing system to cater for a 1 in 100 year recurrence 

interval storm are high and some might say unrealistic. In addition, stormwater infrastructure is 

often overlooked financially relative to roads. Furthermore, South Africa is amidst a precarious 

economic climate thus budget constraints infiltrate down to expenditure proposed at Municipal 

level. Therefore, granting of funds to projects must be based on the level of priority and contribution 

to the socio-economic and environmental welfare of the community.  

The mitigation of these heavy storms is significant in the Isipingo/ Umlazi area due to the location 

at highly flood prone low points. Numerous residential and commercial properties are located within 

the vicinity and were negatively impacted by the instantaneous floods. The consequence of being 

located at a low point is that as the sub-catchments accumulate and stormwater run-off increases, 

the stormwater system fails and thus floods the premises.   

1.2 Location of the Study 

The location of the study is in Southern region of eThekwini Municipality in the townships of 

Isipingo and Umlazi. A sub-catchment accumulating stormwater run-off from a portion of Umlazi 
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kwa-V sections, the Isipingo commercial and industrial area will be the focal point of the study as 

seen in Figure 1.1. The area was chosen due to the devastating impact of the June 2016 and October 

2017 1 in 100 plus recurrence interval storm which endangered the residential, commercial and 

industrial properties in the area.  

The higher portion of the catchment is composed of commercial premises, open areas and informal 

settlements along Prince Mcwayizeni Drive. The Informal settlements do not have formal service 

provision thus waste is predominantly disposed of in the stormwater channels running adjacent. 

Jeena’s supermarket is the low point of the catchment, thus during the flash floods the warehouse 

doors acted as dam gates for the stormwater to pass into the culvert behind the premises.  

Furthermore, a large amount of debris is washed into the stormwater network, thus blocking the 

system and escalating the problem.  

Umlazi V-section is a predominantly mountainous area whereas, Isipingo is situated at lower 

elevations in flatter terrain. The average gradient across the catchment is 14 per cent, therefore 

allowing for faster run-off speed.  

 

Figure 1.1: Locality Map of Site  

Source: ArcGIS, 2018. 
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1.3 Focus of the Study  

The focus of the study will be on performing a cost effectiveness analysis of upgrading a catchment 

in the Isipingo areas stormwater management system. A comparison of conventional stormwater 

management, sustainable urban drainage systems (SUDS) and attenuation facilities based system 

will be conducted. The contribution of the alternative stormwater management systems structures 

to the environmental and social effectiveness will also be integrated into the cost effectiveness 

analysis.  

1.4 Problem Statement 

The costs associated with constructing stormwater management systems can be exorbitant, however 

South Africa is a developing country with an ominous economic climate. Furthermore, the 

environmental and social consideration of stormwater management systems need to be incorporated 

into the decision making process to enable achieving sustainable objectives.  

1.5 Significance of the Study 

The study will assist in determining the cost-effectiveness of upgrading stormwater management 

systems. Due to drastic inclement weather and climate change, 1 in 100 year return period storms 

and greater will occur more often thus requiring adequate stormwater systems to manage the flows. 

In addition, the cost of damage and repairs due to storms is high, thus necessary measures to avoid 

flood damage are required. Government organisations, municipalities and project managers in 

general, can adapt to conducting a cost-effectiveness analysis prior to applying conventional 

infrastructure designs in a slow growth economy. 

The study further emphasizes the importance of prioritizing funding for stormwater management in 

mitigating against negative externalities caused by floods on infrastructure, business premises, 

private property and the community at large. Furthermore, the study can be used towards building 

a template for improving practice, decision making and efficient use of available capital.  

1.6 Stormwater Management System Alternatives 

1.6.1 Conventional Stormwater Management Systems 

Conventional stormwater management systems utilize predominantly grey infrastructure such as 

concrete pipes, channels and manholes at connection points to build a network. Stormwater inlets 

are located along roads at low points and lead the stormwater to outfalls which are located at rivers, 

streams and ultimately the ocean.   
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1.6.2 Sustainable Urban Drainage Systems (SUDS) 

Sustainable urban drainage systems use green infrastructure towards obtaining the same 

functionality as conventional stormwater management systems. The emphasis is on controlling the 

stormwater as close as possible to the source using structures such as water harvesting tanks, bio-

retention basins, green roofs and dual functionality ponds.  

1.6.3 Attenuation Facilities Based Stormwater Management Systems 

Attenuation facilities incorporate the construction of stormwater storage ponds which enable the 

existing stormwater management system to not be inundated.  Attenuation facilities act to simulate 

predevelopment flow rates slowing down the rate of flow in the system at a given period. 

1.7 Purpose of the Study 

The purpose of this quantitative study will be to use the Cost-Effectiveness Analysis theory that 

relates the cost of upgrading a stormwater management system to the outcomes of alternative 

stormwater management designs for the Municipality at the Isipingo prospection site. The 

stormwater management system will be defined as the conduits, culverts, junctions, canals and 

attenuation facilities required to manage the stormwater run-off.  The outcomes will be defined as 

the mitigation of storm damage for a 1and related expenses avoided and retention of employment 

the intervening variable, will be defined as the provision of an economically viable and conducive 

environment to continue operating businesses, thus contributing to Gross Domestic Product (GDP).  

1.8 Research Objectives 

The research objectives are as follows:  

1. To evaluate the cost effectiveness of three stormwater management systems, namely 

conventional pipe networks, sustainable urban drainage systems (SUDS) or incorporating 

attenuation facilities in stormwater management system designs; 

2. To evaluate the social effectiveness of the three stormwater management systems; 

3. To evaluate the environmental effectiveness of the three stormwater management systems. 

1.9 Research Questions 

1. What is the cost effectiveness of the three alternative stormwater mitigation systems? 

2. What is the social effectiveness of the three alternate stormwater designs? 

3. What is the environmental effectiveness of the three alternate stormwater management 

systems? 
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1.10 Overview of the Study 

The study will investigate conventional pipe networks, Sustainable Urban Drainage Systems 

(SUDS) and incorporating attenuation facilities as possible stormwater management configurations.  

The study will not look at the extent of flood damage caused across the whole of eThekwini 

Municipality. Qualitative research methods were not utilized as the perspectives on the extent of 

damage would be subjective. Furthermore, the research will not look into engaging stakeholders 

affected by the floods in Isipingo.  

1.11 Limitations  

The study will not be able to quantify the residential damages that were affected by the floods within 

the vicinity of the area. In addition, due to time and data constraints not the residential and industrial 

members of the public will not be included in the study. Timeous investigations and designs are 

required to enable an adequate data analysis process. The catchment along Prince Mcwayizeni Drive 

from Umlazi to Isipingo will be analysed for the purpose of this study.  

1.12 Conclusion 

Chapter one sought to deliver an overview of the study conducted. The study is necessary due to the 

need for flood mitigation stormwater management systems which are cost effective for the Isipingo 

prospection area. The purpose of the study is to utilize the cost effectiveness analysis theory in 

comparing the costs associated with the construction of alternative stormwater management 

systems, namely conventional stormwater management systems, sustainable urban drainage 

systems and attenuation facilities based stormwater management systems. A quantitative approach 

was adapted to enable an objective outcome. Chapter two is next with the literature review on cost 

effectiveness and stormwater management systems. 
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2. Chapter Two: Literature Review 

2.1 Introduction 

The purpose of the second chapter is to review relevant and available literature on the cost 

effectiveness of stormwater management systems. It serves to provide a holistic reflection on 

stormwater management systems considered in this study and the cost effectiveness thereof. In 

addition, the social and environmental effectiveness of conventional stormwater management, 

SUDS and attenuation facilities as stormwater management systems will be explored.  

2.2 Cost Effectiveness Analysis 

Cost effectiveness analysis is an economic evaluation which compares the costs of alternative 

processes with the outcomes measured. Prior to the early 1980’s, cost effectiveness analysis was the 

predominantly used form of economic evaluation. Cost effectiveness analysis are obligated to have 

effectiveness which is measured in appropriate natural units and ideally expressed in a single 

dimension (Boyle et al., 1983).  

Cost effectiveness analysis is applied to planning and management of organized activity by project 

managers, senior managers and the likes. It enables competing designs to be compared not only on 

price but performance. For example, if a planner was assigned to procure medical waste disposal 

equipment, the performance may be equal or even slightly inferior to its opponent, but substantially 

less expensive and easier to procure. The planner may select it as the more cost effective alternative 

(Project Managers, 2018).  

Effectiveness may be expressed in a single dimension thus allowing for direct comparison of 

outcomes such as marginal cost per unit of outcome. In contrast, in some studies multiple outcomes 

emerge from the alternatives. Robinson (1993) is of the notion that if one procedure emerges as less 

costly and of equal or greater effectiveness than all the other alternatives on each dimension of 

effectiveness, it is the most cost effective alternative. Using multiple dimensions to measure 

outcomes may permit informed decision making as opposed to trying to express outcomes in a 

singular form.  

Culyer (1982) is of the perception that data on effectiveness should be collected in conjunction with 

a clinical trial so that relevant data costs and effectiveness can be collected simultaneously. 

However, conducting trials may be expensive and time consuming and epidemiological evidence 
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may be non-existence, thus secondary data is utilized. This often results in a high dependency on 

assumptions on clinical evidence (Culyer, 1982).  

Cost considerations dominate some scenarios, and so variations in effectiveness are unlikely to alter 

the preferred option. Therefore, the results must be subjected to a range of different assumptions 

about effectiveness, which is possible using a sensitivity analysis. Where there is uncertainty about 

the costs and effectiveness of procedures, sensitivity analysis can be used. The sensitivity analysis 

looks at alternative assumptions of the key variables and examines the sensitivity of the results 

(Briggs, et al., 1993).  Applying a risk opposing strategy is relevant when comparing a new 

technology to an established one. Assumptions are thus drawn when uncertainty arises.  

Other economic evaluation tools exist such as the cost benefit analysis (CBA) which places a 

monetary value to the measure of effect; cost utility analysis and distributional cost effectiveness 

analysis which incorporates concerns for the distribution of outcomes as well as their average level 

and make trade-offs between equity and efficiency (Hosking and du Preez, 2004).  

2.3 Discounting Benefits 

Robinson (1993) posed a strong argument that costs that are acquired at varying points in time need 

to be weighted or discounted to reflect the fact that those which occur in the immediate future are 

of more importance than those which accrue in the distant future. Thus economists questioned if the 

effects of substitute processes should not thus be discounted. Some economists believe it is 

inappropriate to discount benefits. The stance has recently been fuelled after two department of 

health economists agreed to the desirability of a zero discount rate for benefits with Treasury in 

New Zealand (Cairns, 1992).  

The argument is that health is not an interchangeable resource that can be invested to produce health 

in the future, nor does it have a fiscal worth that can be expected to increase with income over time. 

Furthermore, there is no evidence to support opinion that people view future health status as lower 

priority than the current (Robinson, 1993). Other economists, are of the school of thought that 

activities that impact on health such as excessive smoking and heavy drinking implies that people 

discount the future consequences of their actions. Furthermore, biologically humans become frail 

as they age thus the expectation of lower health in the future relative to the present is apparent 

(Cairns, 1992).  
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2.4 The Economics of Infrastructure  

It is apparent that public goods are not governed by rivalry and excludability in contrast to private 

goods. According to RSA (1996) municipalities have a constitutional obligation to provide a safe, 

healthy environment while ensuring economic development and extending the provision of services 

in a progressive and sustainable manner.  

The government continues to play the role of ensuring the provision of traditional infrastructures. 

Furthermore, the often stringent regulations and coordination of infrastructure projects are also 

enforced by the government. Infrastructure is defined as physical resource systems which are 

prepared for the public to utilize and increase productivity for socio-economic development. Natural 

resources may also be classified as infrastructure due to their contribution to the capacity to serve 

communities (Hosking and du Preez, 2004). Traditional infrastructures are found in the form of 

governance systems such as courts of law; communication systems such as telephone networks and 

postal services; transportation systems such as roads, railways, ports and airlines; and basic public 

services such as sewers and water systems (Fisher-Jeffes and Armitage, 2012). 

The provision of infrastructure is thus not intended only for profit gain, but to foster competitiveness 

for the sustainable service by all to participate in economic endeavours, which contribute to the 

growth of the GDP. The view is supported by Frischmann (2007) who argues that instead of 

worrying that too many people will engage in commerce, we should worry that too few will 

undertake the effort.  

Infrastructure asset management in an openly accessible manner may be socially desirable when it 

facilitates positive externalities. The infrastructure is public and nonmarket related, thus no one can 

be discriminated from utilizing the resource. A market mechanism has an inherent bias which often 

infringes on the rights of those who cannot afford to purchase the goods or services (Frischmann, 

2007).  

Lessig (2001) explains that it would be inequitable to allow private ownership of public 

infrastructure as the value of the infrastructure would thus increase as the demand increased leading 

to barriers to entry. In addition, private control may be inefficient and the owner would capture 

social surplus that ought to be distributed among the consumers who contributed to the value 

creation.  
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Ceteris paribus, the demand for a product will decrease as the price increases, thus exhibiting an 

inverse relationship between price and quantity of product demanded. Therefore selling basic water 

services would result in poor communities living in inhumane conditions, thus violating basic 

human rights. Lessig (2001) poses a strong economic argument that resources should be managed 

in an openly accessible manner regardless of identity of the end-user. However access to 

infrastructure is not entirely free, due to payments such as tolls for highways, rates for water 

provision and stamps for posting letters.  

Internationally, an increasing number of cities have set up separate stormwater utilities (SU) and 

begun charging the public directly for stormwater management services in order to secure the 

necessary funding (PWD, 2012). Fisher-Jeffes (2013) proposes that stormwater may be funded by 

provision of a separate stormwater utilities in order to secure funding instead of through general 

municipal rates.  Municipalities across South Africa charge for the provision of portable water and 

sewerage whereas stormwater management funds come from general municipal rates (Fisher-Jeffes 

et al., 2012). Honchell (1986) states that, charging for stormwater is not a way out of financial 

problems, but it offers a means of ensuring adequate resources for effective management of 

stormwater.  

Fees are most commonly levied on the basis of impervious area, which is the effective area draining 

to the stormwater system. Campbell (2010) argues that any stormwater charge must thus be seen as 

a reasonable payment for the provision and management of stormwater infrastructure. This suggests 

that any money raised from fees should be spent on those who paid for the service. The author 

further states that South Africa is behind the rest of the world with numerous other governments 

already having established the legal frameworks and institutional capacity to charge service fees for 

stormwater management (Campbell, 2010).  

One problem with this approach is the level of income disparity in South Africa is the highest in the 

world. According to the latest “poverty trends in South Africa” report, poverty rose in 2015 to 55.5% 

from a series low of 53.2% in 2011(StatsSA, 2019). In addition, the unemployment rate is extremely 

high reaching 27.5% in the third quarter of 2018 (Trading Economics, 2019).  

South Africa uses a subsidiary system where high rates are charged in urban areas to fund poverty 

stricken communities who cannot afford to pay rates (Fisher-Jeffes and Armitage, 2012). Ideally 

the stormwater management fee should be calculated based on the burden that stormwater run-off 

from each property is potentially placing on the environment and the consequential cost to the local 
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authority to prevent damage. In addition, run-off is also generated from public spaces which cannot 

be assigned to individuals (Fisher-Jeffes and Armitage, 2012). 

Adequate water management will require significant financial input in the short term, but the 

contribution to the ecosystem would yield positive results (TEEB, 2010). In contrast, Flynn et al., 

(2018) argues that irrespective of extensive investments in stormwater infrastructure, urban areas 

are still susceptible to water management problems thus the high capital injections are not 

justifiable.  

2.4.1 Externalities on Infrastructure Development 

The economics of traditional infrastructure are regarded to be complex due to the combined effect 

of positive externalities, which are not completely appreciated by the suppliers of goods and services 

within an economic system. It has been observed that from the extension of transportation and 

communication networks, the large capital injections were often accompanied by additional social 

benefits which may not have been premeditated or accounted for (Lessig, 2001).  

Demsetz (1967) suggested that the costs of operating a communal property will not be stated by the 

owner or the community that may benefit, due to an unwillingness to pay for the operating and 

maintenance of the premises. This perspective is limited as Demsetz focused exclusively on 

negative externalities and thus failed to appreciate the positive externalities which can be gained 

from communal property.  

Negative externalities are a result of producers shifting some of their costs onto the community, 

thus depicting less of costs for the production of goods on the supply curves (Janse Van Renburg et 

al., 2015). EThekwini Municipality stormwater regulations stipulate that any development in 

officially drained properties in excess of the allowable 40 percent coverage must be managed by the 

property holder, due to the excess stormwater run-off generated (Stormwater Guideline, 2012). 

Figure 2.1 depicts the effects of development on the amount of stormwater run-off which can 

infiltrate the ground and recharge the water table naturally at a reasonable rate.  
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Figure 2.1: Stormwater Run-off Infiltration Before and After Development 

Source: Author compiled from SUDS, 2018. 

As seen in Figure 2.2, negative externalities accepted by society, supply curve S is generated by the 

producers is to the right of the full-cost curve St. Therefore, Qo, the optimal output is less than Qe, 

the equilibrium output (Janse Van Rensburg, 2015). The local government absorbs the negative 

externalities generated by developers who do not cater for the excess stormwater run-off, thus 

increasing the stormwater infrastructure budget required to mitigate storm damage.  

 

Figure 2.2: Negative Externalities  

Source: Janse Van Rensburg, 2015: 399. 
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In contrast, Frischmann (2007) explains that due to a lack of adequate stormwater infrastructure,  

claims to the value of R300 million were submitted due to stormwater damage during the 10th 

October 2017 floods across eThekwini Municipality. Private property rights are well demarcated by 

the government through laws to protect against damage to private property, therefore allowing for 

parties suffering negative externalities to sue for compensation (Frischmann, 2007).  

 

Tragedy of the commons is due to the abuse of resources with no monetary incentive to private 

establishments. It can be deduced that communities may lack incentives to incur the responsibility 

to dispose of waste responsibly when that responsibility may be transferred externally to society. 

Commonly used stormwater open channels are often polluted by dumping by upstream 

communities, thus decreasing the integrity of the system and amassing to the flooding problem. 

Therefore, it is imperative to pair investments infrastructure with the education of communities to 

enable an appreciation for resources provided. Furthermore, it is the governments mandate to correct 

the market failure caused by a third party on public shared resources such as the air, rivers, streams, 

oceans and parks (Janse Van Rensburg, 2015).  

2.5 The Understated Importance of Stormwater Management Systems 

Several studies have revealed that stormwater management receives significantly low funding 

within municipalities in South Africa (Fisher-Jeffes et al., 2013). This is due to institutional 

rationales, which relate income generation to infrastructure provision. Consequently, stormwater 

management is more often than not the responsibility of the roads department within Municipalities. 

The importance of stormwater management is lost in reactive measures which highlight, flood 

hazards and the rapid disposal thereof (Boshoff, 2009).  

Stormwater management infrastructure is often inadequate due to insufficient budget allocation. 

However, stormwater management systems are imperative towards the preservation of private 

property value and, thus economic sustainability. Boshoff (2009), is of the thought that generally 

municipal infrastructure requires re-investment in maintenance and capital costs, with extrapolated 

results suggesting a current replacement cost of ZAR723 billion for all municipal infrastructure 

under the direct control of municipalities.  

Leading from the Apartheid era when infrastructure development in Townships was not prioritized, 

thus a reactive approach is adopted rather than a proactive surge for development. Furthermore, 
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townships were strategically positioned as labour hubs instead of economic hubs, thus this ideology 

is still perpetuated subconsciously by a lack of infrastructure which enables ease of trade and 

economic development and growth of property values.  

A lack of integration of strategies within the Urban Water Cycle (UWC), which covers sanitation, 

stormwater, water supply and asset management results in an inadequate approach to water services 

(Fisher-Jeffes, 2012). In a water scarce developing country such as South Africa, the silo approach 

to solutions is out dated and requires a change in approach to fully utilize the water and finances at 

our disposal (Fisher-Jeffes, 2012).  

 

2.6 Flooding and Climate Change Correlation 

Alexander (2002) is of the notion that factoring climate change into flood design is unnecessary. 

The author poses the argument that rivers such as the Pienaar, Orange, Upington and Gamtoos have 

data which dates back to 1847 from flood level gauges, however the frequency and magnitude of 

the floods has not increased over the years (Alexander, 2002). The limitation in this study is that 

statistically the probability of a 100 year flood storm is every 100 years, thus one could argue that 

the data set is inadequate.  

Similarly, the view on climate change is supported by Du Plesis and Burger (2015) who argue that 

the rainfall magnitude and frequency have not increased over time. The frequency analysis entailed 

measuring the frequency of rainfall events over a specified threshold. The results indicated 

predominantly inconsistent influence from the magnitude and frequency analysis on changing 

rainfall intensities, thus concluding climate change is not apparent (Du Plesis and Burger, 2015).  

In contrast, Benhin (2006) argues that the magnitude and frequency of rainfall is expected to change 

due to climate change. Benhin (2006) states that an increase in extreme weather conditions such as 

droughts and floods are attributed to the accumulation of greenhouse gases in the atmosphere caused 

in part by the industrial revolution era. Shifting patterns of storm intensity and precipitation have 

been attributed to climate change thus exacerbating flood probability (Horton et al., 2014).  

Brody et al., (2010) found an insignificant deliberation of climate adaptation in policy making and 

planning amongst local, provincial and national decision makers in the United States. Thus 

highlighting the lack of holistic strategies and compliance thereof.  
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Extreme rainfall events have caused significant damage to municipal infrastructure and private 

property over the past decade, particularly in the Western Cape (Holloway et al., 2010). The main 

limitation to most of these studies is the focus on 24 hour or daily rainfall instead of shorter rainfall 

periods. Design storm durations are often shorter than 24 hours, thus shorter duration measurements 

of rainfall are required.  

 

2.7 Conventional Stormwater Management 

Stormwater management is a longstanding environmental and societal challenge for communities 

and Municipalities who implement the infrastructure development. The type of system implemented 

is dependent on numerous factors such as the finances available, the spatial location and inclement 

weather conditions in the area (Flynn and Davidson, 2018).  

Conventional stormwater management systems, as found in most developed countries utilize grey 

infrastructure such as deep storage tunnels, sewer separation projects and regional treatment 

facilities (Flynn and Davidson, 2018). The designs tend to favour centralized subsurface systems as 

a means to solving engineering problems. A typical stormwater management system would be 

composed of a manhole inlets at the edge of the road, which connects to a pipe network extending 

down through manholes towards a suitable outfall as seen in Figure 2.3 below.  

 

Figure 2.3: Typical Long Section  
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Source: eThekwini Municipality, 2018. 

Stormwater pipe systems are predominantly composed of concrete pipes, which have a high 

durability and design life of approximately 50 years given the construction is adequate, thus very 

reliable. However maintenance is required at varying intervals due to structural defects and the 

removal of silt buildup within the system at entrance controls that may clog the structure and 

decrease the capacity.  

2.8  The Utility of Attenuation Facilities for Stormwater Management 

Solutions 

Stormwater attenuation utility is the incorporation of a pond and controlled outlet structure as a 

means of attenuating volumes of run-off which are equivalent to predevelopment conditions 

(Aldous and Buys, 2007). Therefore, the physical alteration of the discharge rate of run-off and 

timeframe from the catchment is stored temporarily in the attenuation pond in the post-development 

phase as seen in Figure 2.4 below.  

 

Figure 2.4: Typical Run-off Hydrograph for Pre and Post and Attenuated Storm Water Flows  

Source: Buys and Aldous, 2007. 
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Attenuation structures may be constructed as ‘dry’ ponds which discharge completely over a 

delayed period after a storm event. The dry ponds may be open air ponds or constructed 

underground. The material utilized to construct the open air ponds varies as seen in Figure 2.5 and 

2.6, where gabion walls and geosynthetic material were used respectively. Underground attenuation 

ponds are predominantly constructed using concrete and brickwork. Alternatively attenuation ponds 

may be constructed as ‘wet’ ponds which constantly have some water (Buys and Aldous, 2007).  

 

Figure 2.5: Typical Open-Air Stormwater Attenuation Pond in Johannesburg Area 

 Source: Buys and Aldous, 2007. 
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Figure 2.6: Construction of Attenuation Pond Using Geosynthetic Material  

Source: Buys and Aldous, 2007. 

The City of Johannesburg has created a stormwater management policy which mandates the use of 

attenuation ponds by private property developers to assist in controlling the volumes and speed of 

stormwater run-off entering the stormwater management system. In a constantly changing urban 

landscape burdened with urbanisation and increased population density, attenuation facilities 

improve the safety and protection against stormwater damage to properties (Buys and Aldous, 

2007). The amount of impermeable surfaces in urban jungles significantly impacts on the time of 

concentration of stormwater run-off thus, increasing the risk of property value and loss of life during 

adverse weather conditions. Furthermore, Robson, Spence and Beech (2005) identified a correlation 

between a decline of biodiversity in natural watercourses and the increase in impermeable surface 

coverage.  

Holistic integration of strategies is required to resolve the challenges facing infrastructure 

sustainability. The Johannesburg Metropolitan in alliance with the Integrated Development Plan 

(IDP) highlights the importance of an effective stormwater policy, however notes the current 

inadequacies of the on-site stormwater attenuation policy (City of Johannesburg, 2004). The 2007/ 

2008 Spatial Development Framework (SDF) indicates an awareness of the stormwater 

infrastructure capacity being surpassed (City of Johannesburg, 2007).  However, the Johannesburg 
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Roads Agency (JRA) are the authorized to implement and manage stormwater infrastructure 

(Johannesburg Roads Agency [Pty] Ltd, 2004).  

The social and environmental impact of incorporating attenuating facilities provides a positive 

externality to the surrounding community by mitigating storm damage and biodiversity in 

ecosystems.  

2.9 Sustainable Urban Drainage Systems 

Due to volatile weather patterns and scarcity of resources, stormwater management methods seek 

to heighten the sustainability of urban water management by incorporating green infrastructure (GI). 

GI allows for stormwater management systems which are designed to restore or protect the natural 

hydrology, thus catering for flood control, water quality improvement or water harvesting (Flynn 

and Davidson, 2018).  

Conventional stormwater management methods often require the destruction of ecosystems, high 

financial injections to construct extensive stormwater management networks, whereas GI offers an 

opportunity for transformational shifts in stormwater management, which are decentralized and 

offer multiple benefits to communities (Shuster and Garmestani, 2015).  

Green infrastructure (GI), green stormwater infrastructure (GSI), low impact design (LID), best 

management practises (BMP) and sustainable urban drainage systems (SUDS) are all synonymous 

terms of reference to the new stormwater management technique which takes cognisance of the 

environment (Fletcher et al., 2014).  

Sustainable urban drainage system (SUDS), propose the treatment of stormwater as close as possible 

to the source in as natural a manner as possible, which is an approach municipalities could look at 

in order to holistically gain multiple benefits that conventional systems do not offer. SUDS, is 

increasingly becoming the accepted best practice for managing stormwater internationally 

(Marsalek and Chocat, 2002). This is due to significant resource alleviation, biodiversity and socio-

economic benefits which hold a compelling argument (Loos and Roger, 2016). As seen in Figure 

2.7 below, stormwater may be collected from residential properties, through drain pipes and directed 

towards gardening systems or swales. Swales are a channel which allows for natural run-off 

infiltration and growth of vegetation. In addition, swales play a role of trapping pollutants and 

reduce the stormwater run-off velocity (U.S EPA, 1992).  
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Figure 2.7: Sustainable Urban Drainage Example  

Source: SUDS, 2018. 

A notable challenge in working in built-up urban environments is the availability of suitable 

localities for SUDS. The spatial and progressive distribution of stormwater volumes in an urban 

location set clear boundaries on which technologies are applicable (Askarizadeh et al., 2015). 

Furthermore, soil characteristics and topography can hinder the process by being incompatible with 

the design (Shuster et al., 2014). For example clayey materials do not allow for water infiltration 

thus, the design of a swale on impermeable soil in the ideal location would be futile. Figure 2.8 

depicts the use of dry wells as a stormwater detention, stormwater planter for natural infiltration, 

storm drain, permeable paving, rainwater harvesting cistern which stems from a green roof.  
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Figure 2.8: Example 2 of Sustainable Urban Drainage Systems  

Source: SUDS, 2018.  

 

Previous studies have found that the main limitations to SUDS are ordinances relating to water, 

environmental issues and the high funding requirements (Stockwell, 2009). A lack of alignment of 

enforcement officials funding expectations relative to financial authorities allowance may also be a 

barrier to implementation. It was found that calculating funding requirements based on the initial 

capital injection without including performance and maintenance costs, or if the community was 

not included in financial incentives it was divergent from the objectives (Parikh et al., 2005).  

However, there is inconsistency with this study given the lack of information on the cost-

effectiveness of SUDS. Nowacek et al., (2003) found that SUDS were enforced by government 

organizations with the objective to meet stormwater management outcomes in a cost-effective 

manner. In addition, GI technologies often exceed the benefits gained from environmental 

improvements and value-add to the community. For example, the utility of green roofs play a dual 

role of moderating stormwater and reducing urban heat islands.  

Technological innovations are not tried and tested thus the legacy of GI infrastructure and the 

consequences thereof are unknown. The education of local communities on the purpose and 

functionality of SUDS contributes immensely to the success of stormwater management (Donovan 
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et al., 2008). SUDS are often natural open stormwater systems, thus dumping by the community in 

the channel designated for swales defeats the purpose.  

2.10 Social Effectiveness 

It is essential for local government project managers and decision makers to understand the social 

consequences of projects. Social impact refers to actions which change the way in which people 

live, work and play. Furthermore, the cultural impact is included which highlights the changes to 

values, beliefs and rational and sense of self within society. Previously, it was a norm for 

infrastructure to be implemented based on economic autonomies in complete neglect of the social 

aspect. For example, the relocation of communities to new ‘better’ households due to the 

construction of a major road arterial would not include the social impact in the project. The change 

in distance relative to their workplaces and ancestral burial grounds of the community members 

would be completely ignored (U.S Department of Commerce, 1994).   

The bias approach would reflect only the positive externalities reviewed. In addition, the impact of 

projects on vulnerable populations such as the poor, elderly, unemployed and culturally distinctive 

must be given attention. Therefore the consideration of the social equity and distribution amongst 

different stakeholders is just as important (U.S Department of Commerce, 1994).  

Communities face the challenge of comprehending the impact of their vulnerability to floods due to 

the inability of stormwater infrastructure to cope with the demands (Loos and Rogers, 2016). 

Dumping in open areas and streams is commonly found in townships, specifically near informal 

settlements due to the lack of service delivery and ignorance amongst other factors. The dumping 

into open channels by informal settlement community members directly impacts on the probability 

to encounter flooding as seen in Figure 2.9 below. 
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Figure 2.9: Dumping in an open Channel along Cato Manor Township  

The social constructs of reality are highlighted as affecting the human environment, thus 

consideration of both the government and communities perceptions and emotions are significant 

(U.S Department of Commerce, 1994).  

The United States National Environmental Policy Act (NEPA) of 1969 appeals for the utility of 

social science in evaluating impacts on human environment to ensure integration of stakeholder 

requirements.   

Shuster and Garmestani (2015) are of the sentiment that public participation is paramount to 

eradicating the misuse of public infrastructure. The education of the communities on the 

infrastructure that is meant to serve them, empowers them to better understand the functionality and 

actions which decrease the capacity thereof. This study explores the social effectiveness of the 

alternative stormwater management systems, however the lack of public participation poses as a 

research gap which can be done in future studies.  

2.11 Environmental Effectiveness 

The urbanisation and development of previously peripheral areas has become a double edged sword. 

An increase in economic emancipation in urban areas is directly related to an increase in 

environmental degradation (Flynn and Davidson, 2018). For example, the majority of Isipingo was 

once a Vlei onto which stormwater run-off from the Umlazi Township and surrounding areas would 

naturally infiltrate. In addition, Isipingo is positioned at a low point relative to Umlazi, thus it 

behaves like a basin. The residential and industrial development have occupied pre-development 
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outfall and attenuation locations thus propagating the stormwater challenge in the area. The 

devastation caused by 1 in 100 year recurrence interval or greater storms in Isipingo along the N2 

route is depicted in Figure 2.10 during the 10 October 2017 floods.  

 

Figure 2.10: Devastating Floods in Isipingo Due to Adverse Storms on 10 October 2017 

Source: Author Retrieved from WhatsApp, 2017. 

According to RSA (1997) the Water Services Act, Act 108 of 1997 specifies that all government 

dominions are obligated to provide water supply services in an equitable, proficient and sustainable 

routine. One could argue that the provision of stormwater management is a right. However, 

eThekwini stormwater management systems are obligated to design for 1 in 3 year recurrence 

interval storms and 1 in 10 year recurrence interval storms at critical points such as low points and 

river crossings (Stormwater Guideline, 2012).  

The re-vegetation and de-canalisation of natural water courses is an imperative operation towards 

the rehabilitation of streams towards achieving the objectives of the Integrated Water Resources 

Management (IWRM) strategy (Buys and Aldous, 2007). Environmental Impact Assessments (EIA) 

look at the threatened or endangers plants and wildlife species in the area (U.S Department of 

Commerce, 1994).  

The incorporation of green infrastructure which encourage the conservation of natural ecosystems 

to provide benefits to communities is essential to achieve environmental, social and economic 
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sustainability. Furthermore, the inclusion of green initiatives in land development and built 

infrastructure planning will produce holistic achievement of objectives, as highlighted in Spatial 

Development Frameworks (SDFs) (Benedict and McMahon, 2001).  

In addition, National Environmental Management Act (NEMA) 1998, holds all persons accountable 

to avoid pollution, degradation of the environment and mitigate ecosystem disruption (South Africa, 

1998b). However, a lack of integration of strategies and policies defeats the objectives as they tend 

to contrast on approach. Furthermore the implementation is a lack as local government enforcers 

are not privy to the strategies and policies in place.  

Stormwater management systems which achieve the functionality required to cope with storms and 

promote biodiversity and preservation of ecosystems are imperative towards sustainability. This 

study aims to explore the utility of alternative stormwater management systems and to measure the 

environmental effectiveness.  

2.12 Conclusion 

The literature review seeks to make available understanding on the cost effectiveness of stormwater 

management systems considered namely conventional pipe networks, sustainable urban drainage 

systems and attenuation facilities based stormwater management. The utility of multiple dimension 

as a means to measure cost effectiveness enables informed decision making and comparison of 

design alternatives for project managers, although traditionally one dimension is considered.  

Infrastructure distribution is the duty of the government to enable efficient trade and socio-economic 

growth for all members of the public. Stormwater infrastructure is mandated for all members of the 

public to occupy safe conducive environments however, only 1 in 3 and 1 in 10 year recurrence 

interval storms are designed for by EThekwini Municipality. Furthermore, 25 years into democracy 

basic infrastructure is still a lack in Townships.  

There are positive externalities which are not appreciated with infrastructure development in only 

reviewing the economic consideration and negative externalities which the public impose onto 

government infrastructure which are also neglected which exacerbate infrastructure costs therefore, 

resulting in market failure and tragedy of the commons.  

Conventional pipe networks as stormwater management systems are utilized due to their reliability 

and known stormwater functionality. Attenuation based facilities are a commanding structure for 
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the purpose of temporarily storing stormwater run-off to allow for pre- development flow rates post 

development. SUDS are best practise internationally, however the implementation is slow locally.  

The impact of climate change and the need for adaptation is contentious topic due to the increase in 

intensity and frequency in storms and floods over time, and the correlation thereof. Retrofitting 

stormwater management systems in urban developed environments is also a contentious challenge, 

due to a lack of space for the required infrastructure.  

SUDS look at the holistic objectives of the infrastructure and the multiple benefits which could be 

possibly reaped from the design implemented. The resource alleviation, biodiversity and socio-

economic benefits hold a compelling argument to the utility of green infrastructure as a sustainable 

means to stormwater management system implementation.  

Comprehension of the social effectiveness of infrastructure is paramount to integrating the 

objectives of projects and strategies. Infrastructure serves a functionality, however the incorporation 

of social effectiveness strengthens the utility. Communities are vulnerable to economic 

consideration taking precedent, thus the exclusion of public participation process is a research gap. 

However, when public participation is necessary in a project, vulnerable communities are not privy 

to contribute to the design alternatives proposed for infrastructure development.  

Infrastructure development is often at the expense of environmental consideration, which rescinds 

biodiversity and eco-systems. The inclusion of environmental effectiveness to stormwater 

management systems is paramount to achieving sustainability and compliance to existing water and 

environmental policies such as IRWM and NEMA.  

Economic consideration is the predominant factor to infrastructure development, however the need 

for environmental and social effectiveness to be integrated is expressed by the strategies such as the 

Integrated Development Plan (IDP) and local government Spatial Development Frameworks 

(SDFs) which highlight holistic correlation of departmental objectives and regulations such as those 

set out by NEMA which is associated with environmental accountability. The lack of alignment of 

the above strategies and regulations with what is enforced at a local government level is apparent 

due to the lack of green infrastructure utility although it is best practise internationally. Chapter 

three will follow to present the research methodology used to conduct this study.  
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3. Chapter Three: Research Methodology 

3.1 Introduction 

The purpose of the third chapter is to make available understanding of the research methodology 

utilized in collecting data for this study. The objectives of this study are to conduct a cost 

effectiveness analysis of stormwater management system alternatives for a catchment in the Isipingo 

and neighbouring Umlazi area and evaluate three design alternatives as stormwater management 

systems. Chapter one provided comprehension to the need for the study due to recent devastating 

floods. In Chapter two, the literature review highlighted concerns relating to the understanding of 

the importance of stormwater management systems and the economic implications thereof.  

The research methodology was designed to answer the research questions posed on cost 

effectiveness of stormwater management system alternatives. A scenario planning methodology 

was chosen to compare conventional pipe networks, SUDS and incorporating attenuation facilities 

in stormwater management system designs. The holistic contribution of infrastructure development 

to communities is important, therefore the environmental and social effectiveness of the stormwater 

management systems will also be incorporated into the cost effectiveness analysis by utilizing a 

multi-criteria decision matrix.  

3.2 Aims and Objectives 

The aim of this study is to establish the cost effectiveness of alternate stormwater management 

systems within eThekwini Municipality, specifically for a catchment which encompasses the 

Isipingo and Umlazi area.  

The research objectives are as follows: 

1) To evaluate the cost effectiveness of three stormwater management systems, namely 

conventional pipe networks, sustainable urban drainage systems (SUDS) or incorporating 

attenuation facilities in stormwater management system designs;  

2) To evaluate the social effectiveness of the three stormwater management systems; 

3) To evaluate the environmental effectiveness of the three stormwater management systems. 

3.3 Research Strategy 

The research strategy that will be used in this study is quantitative. Secondary data will be utilized 

to conduct a scenario based research methodology. A quantitative research strategy is appropriate 

in addressing the research question as it enables an objective analysis of the cost implications of 
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design alternatives. Furthermore, a numerical method eliminates personal perceptions and 

subjective opinions to produce results which are highly dependable and can be easily duplicated 

(Saunders et al., 2012).  

The purpose of scenario based research is to enable a comparison of design alternatives that best 

serve the objectives of all stakeholders. The primary objective is to design alternate stormwater 

management systems which mitigate 1 in 100 year recurrence interval storms and compare the cost 

effectiveness thereof. Economic consideration of the designs is of high importance in the current 

economic climate in South Africa. South Africa was in a recession in the first and second quarter of 

2018 prior to a 2.2% growth in the third quarter (STATSSA, 2018).  Furthermore, a multi-criteria 

decision matrix will incorporate the social and environmental effects of the alternate stormwater 

management systems. Cost, environment and social effectiveness will weigh 60, 30 and 10 percent 

respectively towards a holistic and sustainable solution.   

Strategic design scenarios will be utilized to compare stormwater network design alternatives. 

Scenario planning enables the pros and cons of each alternative to be weighed against the set benefit. 

This tool enables the convergence of social and economic challenges which are often in conflict 

(Aldrich, 2018). The incorporation of a multiplicity of outcomes further strengthens the objectivity 

of the results.  

Furthermore, collecting and comparing the Bill of Quantities (BOQ) using a set cost criteria for the 

stormwater design alternatives allows for a faster turnaround time as opposed to conducting 

interviews from project managers to gather their perspectives on the proposed stormwater 

management systems.  

3.4 Research Paradigm and Approach 

The positivist research paradigm and a deductive approach underpin the quantitative research 

design, thus reflecting positivist philosophical assumptions. The use of a multi-criteria strategy to 

arrive at a cost effective solution to the stormwater management systems presented, is appropriate 

for addressing the research questions as it takes into account the needs of different stakeholders, the 

residences, commercial property owners and the municipality. Moreover, a cost effective solution 

will be chosen to serve all stakeholders whilst including the environmental and social effectiveness.  
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3.5 Study Site  

The location of the study is in the Southern region of eThekwini Municipality in the townships of 

Isipingo and Umlazi. A catchment accumulating stormwater run-off from a portion of Umlazi kwa-

V sections, the Isipingo commercial and industrial area will be the focal point of the study as seen 

in Figure 3.1. The catchment area is highlighted in red and amounts to 56.05 hectares.  The area was 

chosen due to the devastating impact of the June 2016 and October 2017 1 in 100 year recurrence 

interval storm which endangered the residential, commercial and industrial properties in the area.  

 

Figure 3.1: Locality Map of Catchment and Existing Stormwater Management System within Catchment 

Sourced: ArcGIS eThekwini Municipality 

The higher portion of the catchment is composed of commercial premises, open areas and informal 

settlements along Prince Mcwayizeni Drive. The Informal settlements do not have formal service 

provision thus waste is predominantly disposed of in the stormwater channels running adjacent. 

Jeena’s Supermarket is the low point of the catchment, thus during the flash floods the warehouse 

doors acted as dam gates for the stormwater to pass into the culvert behind the premises.  

Furthermore, a large amount of debris is washed into the stormwater network, thus blocking the 

system and escalating the problem.  
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Umlazi V-section is a predominantly mountainous area whereas, Isipingo is situated at lower 

elevations in flatter terrain. The average gradient across the catchment is 14 per cent, therefore 

allowing for high stormwater run-off velocity.  

There are two existing formal stormwater systems which drain the catchment, as demarcated in 

green in Figure 3.1 above. The systems combine at Jeena’s Supermarket and drain to a culvert 

passing under the railway line. The culvert further connects into another culvert which flows through 

the bus depot and towards a canal system, which discharges into a Vlei between the N2 highway 

and the R102. Water collecting in the Vlei drains via a canal system through Isipingo and into the 

Indian Ocean, through an outfall.  

3.6 Stakeholders in the Study 

Stakeholders are defined as individuals, groups or organizations that have a vested interest in the 

outcome of a project (Project Manager, 2018).  The stakeholders relevant to this study will be 

members whom are affected by the stormwater within the selected catchment area, thus eThekwini 

Municipality, the residential community of Umlazi V-section, and the commercial property owners 

within Isipingo and Umlazi are the stakeholders for this study.  

eThekwini Municipality, will supply the resources required to conduct the research. Furthermore, 

the study will contribute towards the development of cost effective consideration when project 

managers within the Municipality consider design alternatives.  

The residential community of Umlazi V-section are directly affected by the impact of the severe 

storms, thus the mitigation thereof grants a safe and conducive environment for residing.  

The commercial property owners on the downstream of the catchment were negatively affected by 

storms in previous years, which lead to insurance claims in the millions of ZARs and loss of 

business. The mitigation of the storms would enable the prevention of damage to property, 

preservation of property value, jobs and contribution to the GDP.   

3.7 Research Instruments 

The primary research instruments utilized in this study are Personal Computer Storm Water 

Management Model (PCSWMM) and Microsoft excel. PCSWMM was used to model the 

stormwater management plans whilst Microsoft excel was used to analyse the data collated. The 

secondary research instrument utilized was the eThekwini Municipality Geographic Information 

System (GIS), where attribute data is stored and analysed in spatial maps (ArcGIS, 2018).  
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In 1978, Computational Hydraulics International (CHI) established themselves as software 

developers, thus introducing PCSWMM. PCSWMM is a stormwater management modelling 

software, with the latest upgrade, version 7.1.2480, being introduced in 2017. A licence was 

purchased by eThekwini Municipality for the purpose of modelling stormwater management 

solutions.  

PCSWMM was chosen due to its ability to model the stormwater management design alternatives 

which can be analysed from an economics perspective. The procedure for recording data fits the 

research as an in-built scenario planning tool exists within the software. Furthermore, it addresses 

the research question number one which is “To evaluate the cost effectiveness of three stormwater 

management systems, namely conventional pipe networks, SUDS or incorporating attenuation 

facilities in stormwater management system designs”. Attendance of the PCSWMM course from 11 

to 14 September 2018 was completed to gain understanding of the abilities of the software, which 

was conducted in Cape Town by the developers of the software, CHI water.  

Microsoft Excel was used for its ability to calculate, tabulate and statistically analyse data; therefore 

enabling data entry, analysis and visualisation of results. The production of the multi-criteria 

scenario matrix to weigh the economic, social and environmental effectiveness of the stormwater 

management systems was also prepared in Excel.  

PCSWMM allows for the input of accurate data from Digital Elevation Maps (DEM), which is 

retrieved from verified sources such as Light Detection and Ranging (LIDAR) surveys (Survey, 

2016). Furthermore, PCSWMM allows for the importing of known attributes such as soil properties 

and rainfall data, which are appropriate to the location.  

Well renowned reviews of PCSWMM as a research instrument proved difficult as no review panels 

from accredited bodies were found, thus being a shortcoming of this study.  

The data collection method is scenario based research. The rationale is that it enables an objective 

analysis and comparison of design alternatives. Furthermore, a numerical method eliminates 

personal perceptions and subjective opinions to produce results which are highly dependable and 

can be easily duplicated.  
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3.8 Study Procedure 

The research design called for the use of secondary data to conduct a scenario based research 

methodology. A quantitative research strategy was appropriate in addressing the research question 

as it enables an objective analysis of the stormwater management system design alternatives.  

The purpose of scenario based research was to enable a comparison of design alternatives that best 

serve the objectives of all stakeholders. The primary objective was to design alternate stormwater 

management systems which mitigate 1 in 100 year recurrence interval storms and to compare the 

cost effectiveness thereof. The inclusion of social and environmental effectiveness produced a 

multi-criteria research, which strengthened the objectivity.  

The literature review provided insight into the material using secondary data to emphasize 

challenges which include economic, social, environmental and legislative concerns.  

The methodology procedure was conducted as seen in the following flowchart, Figure 3.2:  

 

Figure 3.2: Methodology Procedure Flowchart  

 

3.8.1 Stormwater Run-off Calculations 

 

Storm recurrence 
interval modeling using 

Rational Method

Identify Alternative 
Designs

Generate stormwater 
management systems 
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implications of 

alternatives

Environmental 
effectiveness of 

alternatives

Social effectiveness of 
alternatives

Generate Multi-Criteria 
Decision Matrix

Determine most cost 
effective stormwater 
management system
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Manning’s Equation Q=(1/n)*(D/4)^2/3*(S1/100)^1/2*(Π*(D^2/4)) 

 

Where: 

   Q = Capacity of pipe required (m3/s) 

   n = Roughness coefficient 

   D = Diameter of pipe required (m) 

   S1 = slope of pipe used (%)  

 

 

3.8.2 PCSWMM Modelling 

 

The conventional stormwater management system was modelled first using PCSWMM. The design 

was composed of standard concrete pipes and stormwater manholes which are composed of 

brickwork, mortar and concrete. Pipes are referred to as conduits whilst manholes are junctions on 

PCSWMM. A LIDAR survey clip was imported into PCSWMM to transfer geographic information 

from ArcGIS. The model was then created by placing conduits and junctions appropriately along 

the flow path with an outfall at the end, as seen in Appendix 7, a long section of the conventional 

stormwater management system (PCSWMM, 2016). Watershed delineation was used to accurately 

split the catchment into sub-catchments. The characteristics of the catchment such as infiltration, 

imperviousness and rainfall gauge are required to be setup prior to running the simulation. Pressing 

run on the PCSWMM software enabled the model to simulate and see the profile and behaviour of 

the stormwater run-off through the system. The results indicated a flow rate along the flow path.  

In the event of surcharging or flooding of the stormwater management system, the model depicts 

the junctions that are not managing in red at a specific time as seen in Appendix 8 below.  

The design can thus be altered and run again to ensure the surcharging and flooding points are 

removed from the system. The status tab shows the flow rates and checks required to validate the 

design.  
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Design alternative two considered the use of SUDS to alleviate for a 1 in 100 year recurrence 

interval storm. A new file was established on PCSWMM using the scenario planning manager to 

duplicate the file and rename it accordingly. Scenario two uses swales along the stormwater run-off 

path and a communal sports field which acted as run-off storage during storms. The model was 

simulated to determine the stormwater run-off behaviour within the SUDS. The long section of the 

SUDS profile is seen in Appendix 9 below.  

 

Scenario three was created to model the simulation of the attenuation facilities based stormwater 

management system. Attenuation one was composed of gabion walls and the natural ground as base, 

whilst attenuation two was composed of concrete. The flow path was setup with pipes connecting 

the two attenuation facilities, one at the top in an open field and the other at the bottom of the 

catchment underground beneath Jeena’s Supermarket parking area. The model was run to simulate 

the flow behaviour as seen in Appendix 10 below. The flow rate was thus checked for any 

inconsistencies (PCSWMM, 2016).  

The PCSWMM modelling step by step guideline is found in Appendix 2 or further help can be 

obtain via the PCSWMM help link as follows:  

 http://www.chiwater.com/Software/PCSWMM.NET/Help/ 

Due to the lack of clarity of the long sections from the PCSWMM modelling, drawings were done 

on Civil Designer-3D to better illustrate the long sections of the stormwater management 

alternatives as found in Appendix 4 to 6. 

3.8.3 Cost Effectiveness Analysis 

Upon completion of the stormwater alternative designs, the cost implications of constructing the 

conventional stormwater system, SUDS and the attenuation based stormwater system was 

determined by gathering quotation from suppliers for the bill of quantities (BOQ) and collated on 

an excel spreadsheet. 

15% of the total BOQ value will be added to the sub-total of each stormwater management system 

as the contractor’s labour and profit margin. Furthermore, 15% Value Added Tax (VAT) will be 

included to attain an ultimate total.  
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able to stipulate the sizes of the conduits and medians required to prevent flooding. PCSWMM will 

convey the efficiency of each design alternative by displaying the flow rate, head and conduits sizes 

required to cope with a 1 in 100 year recurrence interval storm. The data will be organized in tables 

and long sections from the research instruments.  

The resulting BOQs for the conventional stormwater system, SUDS and attenuation based system 

will contribute to the cost effectiveness analysis utilising the set criteria. A score will be given to 

the stormwater management system based on the associated costs. The environmental effectiveness 

will be analysed using the set criteria to deduce the environmental consideration of each stormwater 

management system. The social effectiveness will be deduced using the set criteria to establish the 

social consideration of the structural components of the stormwater management systems.  

The multi-criteria decision matrix will be employed to incorporate the cost, environmental and 

social effectiveness of the alternative stormwater management systems by weighting the score 60, 

30 and 10 respectively to achieve sustainable, holistic objectives. Furthermore, the multi-criteria 

decision matrix enables an objective comparisons of the alternative stormwater management 

systems.  

3.10 Ethical Consideration 

Participation of people was not utilized in this study, thus consent agreements were not drafted. A 

gatekeepers letter was retrieved from eThekwini Municipality as a means of getting approval to 

conduct the research and utilize the available data and tools as seen in Appendix . The ethical 

clearance is also attached in Appendix in compliance with the institution’s ethical procedures.  

3.11 Conclusion 

The purpose of the third chapter was to explain the research methodology used for this study. Cost 

effectiveness is a contentious issue, in a developing country where infrastructure is required 

however, the costs may be inflated.  

The PCSWMM modelling was conducted compare the alternative stormwater management designs 

considered and determine the components required to construct a system which mitigates a 1 in 100 

year recurrence interval storm. The cost effectiveness analysis was conducted by compiling BOQs 

for the conventional, SUDS and attenuation based stormwater management system. Modelling is an 

iterative process which requires trying different combinations of components to try and resolve the 

problem at hand.  
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Considering the cost alone in the implementation of projects is bias and perpetuates a silo approach 

which is not sustainable thus, the inclusion of environmental and social effectiveness criteria were 

implemented. The criteria was set out to evaluate each stormwater management system and the 

scoring thereof.   

The utility of a multi-criteria decision matrix was employed to integrate the cost, environmental and 

social effectiveness in aligning with existing strategic policies and the sustainability thereof. 

Furthermore, to arrive at a weighted cost-effectiveness analysis which approaches the project 

objectively and holistically. The results and discussion of the stormwater management systems will 

be further discussed in chapter four.  
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4. Chapter Four: Results and Discussion 

4.1 Introduction 

The purpose of the fourth chapter is to present and analyse the information collected from the 

stormwater run-off calculations, PCSWMM modelling, environmental and social effectiveness 

assessments of the alternative stormwater management systems and the cost effectiveness analysis 

which utilizes the multi-criteria scenario matrix as a decision making instrument. The discussion of 

the results will follow accordingly.  

4.2 Stormwater Run-off Calculations 

The input of the catchment characteristics resulted in a Time of Concentration (Tc) of 9.8 minutes 

which is below the allowable 15 minutes, therefore 15 minutes was used to deduce a run-off flow 

rate of 38.10 m3/s using the rational method as seen in Table 4.1 below.  

Table 4.1: Stormwater Run-off Calculation  

Source: Author calculated using EThekwini Municipality Stormwater Guidelines (2012).  

 

Location: Isipingo/ Umlazi KwaJeena Outfall

Input Equations Amount Unit

Area, A A=(L*B)/10000 56.05              Ha

Catchment Average Slope, S1 S1=Y2-Y1/X2-X1 0.146

Run-Off Length L1=sqrt(L2+B2) 1232 m

Actual Time of Concentration, Tc1 Urban min Tc 15 min

Kerby Time of Concentration, TCk1 TCk1= 36(r1L1/1000/S1
0.5)0.467 40.19              min

Kerby Factor r1 Roughness Factor Table 0.30

where runoff L, >200m 

Streamflow Bransby-Williams Tc Tc=60(0.87*L2/109/S)0.385 9.80 min

Combined Area Sum(A)=A1 56.05              Ha

Recurrence Interval, RI 100 years

RI Reduction Factor, ft1 Recurrence Interval Table 1

Run-Off Coefficient, C1 C=(Cs+Cp+Cv)xft1 0.95

Rainfall Intensity, i1 Rainfall Gauge, interpolate on Tc used 257.6 mm/hr

Runoff Flow Rate, Q1 Q= ft*C*I*A/360 38.10              m3/s

Stormwater Design Spreadsheet

Catchment 1

Rational Method

Overland Flow
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Using the 38.10 m3/s flow rate and the slope of the pipe of 12%, a required diameter of 1.68m was 

deduced using the Nomograph as seen in Appendix 1. Manning’s equation therefore generated a 

required flow rate based on the required diameter. Due to the fact that the pipe diameter sizes are 

determined by manufacturers, an appropriate size that is slightly greater than the required diameter 

was thus chosen as the actual pipe diameter. A pipe diameter of 1.8m was ultimately chosen, which 

has a capacity to handle a stormwater run-off flow rate of 43.12 m3/s as seen in Table 4.2 below. 

Therefore a 1.8m diameter pipe will utilize 66.7% of its capacity to withstand a 1 in 100 year 

recurrence interval storm.  

The 66.7% utility allows for contingencies where a storm, which is greater than the one designed 

for occurs, thus allowing for an additional 5.02 m3/s can be catered for. This safety factor is 

imperative to overall flood mitigation, in cognisance of the probability of stormwater management 

systems being polluted and blocked by debris, specifically during flood events which decrease the 

capacity. Furthermore, taking climate change into account, the intensity of storms is likely to 

increase, thus additional capacity decreases the risk of flooding. The costs of construction increase 

annually due to escalation, therefore it is always better to implement infrastructure, which will not 

require extensions in the foreseeable future.  
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Table 4.2: Outlet Pipe Sizing Calculation  

Source: Author generated from EThekwini Municipality Stormwater Guideline, 2012. 

 

 

4.3 PCSWMM Modelling 

4.3.1 Conventional Stormwater Management 

Arriving to the final configuration for the conventional stormwater management system was an 

iterative process. The system indicated significant surcharging at junctions when using 1.2 diameter 

pipes as seen in Figure 4.1 below. Ultimately using 1.8 diameter pipes and a sports field as a storage 

pond assisted the conventional stormwater management system to cope with the 1 in 100 year 

recurrence interval storm as seen in Figure 4.2 of the profile and the layout in Figure 4.3. The 

components of the stormwater management system is captured in Table 4.3 and 4.4 below.  

Roughness Coefficient, n Smooth 0.012

Diameter of Pipe Required, Dreq From Nomograph 1.68 m

Capacity of Pipe Required, Qreq Qreq=(1/n)*(D/4)2/3*(S1/100)1/2*∏*D2/4 35.870 m3/s

Diameter of Pipe Used, Du1 1.8 m

Survey Slope of Pipe Used, S1 12.00 %

Length of Pipe Used,Lu1 980 m

Capacity of Pipe Used, Qu1 Q=(1/n)*(D/4)2/3*(S1/100)1/2*∏*D2/4 43.12 m3/s

Max. Flow Velocity in Pipe Used, Vmax1 V=Q/∏D2/4 16.952 m/s

Flow Time in Pipe Used, T T=L/V/60 0.964 min

Time of Concentration at CP Sum(Tc) 15.964 min

Outlet Pipe Sizing

Mannings Equation
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Figure 4.1: Conventional Configuration with Surcharging  

Source: PCSWMM, 2018. 

 

Figure 4.2: Conventional System Corrected Profile  

Source: PCSWMM, 2018. 





56 

 

4.3.2 Sustainable Urban Drainage Systems 

The SUDS model was simulated by changing the conduits along the same alignment into trapezoidal 

shaped swales with a roughness coefficient of 0.4 instead of 0.013 for concrete pipes. Running the 

simulation resulted in numerous surcharges and flooding along the path as seen in Figure 4.4, thus 

additional several simulations were done to correct the model with the profile displayed in Figure 

4.5.  

 

Figure 4.4: SUDS Surcharging Model  

Source: PCSWMM, 2018.  

 

 

Figure 4.5: SUDS Corrected Model  

Source: PCSWMM, 2018.  
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attenuation must be considered due to the space constraints of providing infrastructure in urban 

areas.   

The utility of green infrastructure is more cost effective relative to conventional and attenuation 

based stormwater management systems. The SUDS design requires 40.84 percent of the 

conventional stormwater management design budget and 13.24 percentage of the attenuation 

facilities design budget to be executed. Consequently 2.45 SUDS based designs can be implemented 

on the conventional stormwater management systems budget requirement and 7.55 SUDS based 

designs may be implemented on the attenuation budget.  

Table 4.2: Conventional Stormwater Management System Bill of Quantities 

 

Table 4.3: Sustainable Urban Drainage System Bill of Quantities 

 

Item description Rate (ZAR) Quantity Unit Value (ZAR) 

Preliminaries and General 511 770.00 1 PC Sum 511 770.00

Supply and installation of 2m diameter concrete HDPE pipes 3500 700 m 2 450 000.00

Standard Type B Manholes at 1-3m depths 1500 10 15 000.00

Excavation of existing unsuitable material 100 6300 m3 630 000.00

Importing suitable fill material 150 2000 m3 300 000.00

Reinstatement of  site 80 210 m3 16 800.00

Sub-Total 3 923 570.00

15% Profit and Labour 588 535.50

Sub-Total 4 512 105.50

VAT 676 815.83

TOTAL 5 188 921.33

Conventional Stormwater Management System Bill of Quantities

15%

Item description Rate (ZAR) Quantity Unit Value (ZAR) 

Preliminaries and General 205 500.00 1 PC Sum 205 500.00

Excavation of existing unsuitable material 100 4000 m3 400 000.00

Importing suitable fill material 150 360 m3 54 000.00

Supply and planting of suitable swale vegetation 200 3200 m2 640 000.00

Construction of earth berms around sports field 120 800 m3 96 000.00

Grass sodding 50 3600 180 000.00

Sub-Total 1 575 500.00

15% Profit and Labour 236 325.00

Sub-Total 35 448.75

VAT 271 773.75

TOTAL 2 119 047.50

15%

Sustainable Urban Drainage System Bill of Quantities
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in Table 4.14. The question posed in criteria one explored the use of materials in the construction 

of the stormwater management designs. The utility of concrete as the base material resulted in the 

conventional system receiving a 2 for the first criteria, relative to a 5 for SUDS which utilizes soil 

material to construct berms for storage and vegetation in a swale to manage the stormwater run-off 

velocity and infiltration. The attenuation facilities scored a 3 due to the use of gabion baskets and 

concrete for attenuation facilities. Gabion basket walls are composed of dump rock and mesh wire, 

thus are quite environmentally friendly.  

Criteria two measured the degrading of any ecosystems for the construction of the stormwater 

management system. The three design alternatives received a scoring of 3 due to the fact that no 

known or earmarked ecosystem was disturbed however, the area was vacant thus a possible natural 

habitat for some wild fauna and flora. 

SUDS received a 5 for criteria three due to the creation of biodiversity within the swales as opposed 

to the attenuation facilities which received a 3. The fourth criteria evaluated the sustainability of the 

design which found the conventional system to score 2 relative to 5 and 3 for SUDS and attenuation 

facilities respectively. Sustainability was measured by the overall alignment of the stormwater 

management system with environmental policies and strategies which are in place. The utility of 

green infrastructure was found to be most environmentally effective.  

The question posed in criteria 5 was to determine if the stormwater management system achieves 

the needs of the community. From an environmental perspective, SUDS attained a scoring of 5 

relative to 3 for both the conventional stormwater management system and attenuation facilities due 

to the designs ability to harness natural resources.  

 

 

 

 

Table 4.6: Environmental Effectiveness Analysis Results 

No. Criteria Scenario 1: 

Conventional Pipe 

Network  

Scenario 2: 

Sustainable 

Urban Drainage 

Scenario 3: 

Attenuation 

Facilities  
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The third criteria looked at the facilitation of social effectiveness of the designs. The SUDS attained 

a score of 4 for criteria three whilst the attenuation facilities attained a 2, due to the fact that the 

SUDS system creates a sports and recreation field which can also be used for socializing when there 

are no storms. The attenuation facilities do not make any allowance for socializing on the 

stormwater management structure, due to the gabion baskets on the ground surface.  

The question posed by criteria four addresses the improving of social constructs by the construction 

of stormwater management system in this area. The implementation of a formal stormwater 

management system in a Township which has informal settlements within close proximity, 

contributes immensely to removing social constructs due to the general lack of service delivery in 

these areas. Therefore the fourth criteria saw conventional and attenuation facilities designs scoring 

5 whilst SUDS scored 3. SUDS may not be understood by the communities thus, they pose a risk 

of perpetuating the social constructs the designs are attempting to remove. The open system is prone 

to pollution thus a probable safety hazard if the community is not engaged in public participation 

workshops regarding the purpose of the SUDS.  

Criteria five posed a question addressing the culture change the stormwater management system 

may bring to the community. All three of the designs were found to positively change the culture of 

the community, due shift in perception and dogmas of the communities sense of identity, thus the 

scoring for all three designs is 4.  

 

 

 

 

 

 

Table 4.7: Social Effectiveness Analysis Results 

No.  Criteria Scenario 1: 

Conventional 

Pipe Network  

Scenario 2: 

Sustainable Urban 

Scenario 3: 

Attenuation 

Facilities  
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to its vulnerability to the gabion baskets being torn which may require reconstruction as the integrity 

of the structure would be compromised.  

Green infrastructure is currently misunderstood by most project managers due to a lack of exposure 

to the innovation. The implementation thereof is at a slow rate relative to international practices 

However, the extent of knowledge held by project manager’s on green infrastructure was not 

measured in this study.  

The use of green infrastructure such as water harvesting, green roofs and SUDS are best practice 

internationally (Marsalek and Chocat, 2002). Environmental legislation and policies are enforced 

by stakeholders such as EDTEA, however the implementation and compliance by project managers 

is indefinite.  

The conventional management systems are highly dependable and well renowned due to the 

majority of concrete pipes being operated over decades without failure. However, ogee joint pipes 

were enforced prior to spigot and socket joint pipes which fail predominantly at the joints and create 

sinkholes along road pavements, therefore the reliability on pipe networks is not absolute.  

Attenuation facilities based designs assists with the storing stormwater temporarily, thus reducing 

the flow rate and velocity at which the run-off enters the system. The benefit gained in the additional 

storage is important to a flood prone location. Finding solutions to a built up environment includes 

the consideration of unconventional underground storage facilities which may have high capital 

investments with long term effectiveness (Buys and Aldous, 2007).  

The combination of design configuration is inevitable as conventional pipe networks are 

predominantly utilised. The Isipingo and Umlazi catchment in question is characterised by a steep 

average gradient thus the stormwater run-off is prone to high speeds. These characteristics in 

essence necessitate the utility of a storage facility to assist in mimicking predevelopment stormwater 

run-off behaviour (Buys and Aldous, 2007).  

The multi-criteria decision matrix is utilized as a scenario planning tool thus an objective 

quantitative approach may seem sufficient at this point. However, the social consideration was 

difficult to score due to a lack of engagement with the community to include their opinions on the 

infrastructure which may not be suitable for their daily circumstances. An objective non-community 

consultative approach does not fully capture the needs of the community (Shuster and Garmestini, 
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2015). In contrast, the community may not be in a position to contribute on what they require due 

to a lack of expertise on the overall function of stormwater management systems.  

The use of the multi-criteria decision matrix as an essential part of the cost effectiveness analysis 

shows a willingness to integrate and align strategies which promote both infrastructure development 

and the preservation of environmental and social cognisance in achieving sustainable service 

delivery. Furthermore, it is imperative for the dismantling of silo departmental objectives within a 

holistic representation of government objectives.  

The implementation of infrastructure without public engagement in South Africa, often leads to 

protest action by neighbouring impoverished communities whom feel excluded from the 

opportunity to acquire skills or generate income. Therefore public participation is crucial to the 

successful implementation of any stormwater management system of this magnitude (Shuster and 

Garmestini, 2015). The appropriate time to engage the public and practical extent of their 

contribution is unknown.  

Consequently, eThekwini Municipality project managers are required to engage the community via 

the assistance of the Ward Councillor regarding works to be implemented within their jurisdiction. 

The Councillor often acts as a liaison between the social needs of the community and the economic 

resources of the project manager, thus assisting in tailoring the design to incorporate social benefits.  

The SUDS design being the most cost effective alternative in this catchment does not mean that the 

same would apply for other catchments, due to the varying characteristics of catchments in different 

locations.  

 

 

4.9 Conclusion 

The purpose of this chapter was to consolidate the cost effectiveness of the conventional, SUDS and 

attenuation facilities based stormwater management systems. The contribution of the economic, 

social and environmental effectiveness were given opportune consideration in reaching a holistic 

conclusion on the cost effectiveness of the stormwater management systems proposed. The 

strengths and shortfalls of the proposed stormwater management systems were analysed.  
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The conclusion drawn from the multi-design criteria matrix indicate that SUDS are the most cost 

effective with a score of 4.12 in comparison to attenuation facilities and conventional pipe networks 

in this study. In contrast, SUDS were found to be unreliable due to the fact that they are a relatively 

new approach to solving stormwater management challenges in South Africa. Green infrastructure 

takes cognisance of the environment and the social aspects of solutions thus, adaptation to this 

internationally recognised best practise is pertinent for sustainability and alignment with set 

regulations.  

Conventional stormwater management systems scored 2.22 when weighted using the multi-decision 

matrix in measuring its cost effectiveness. Conventional stormwater management systems are the 

normal practice and are highly dependable from an engineering perspective, however the 

environmental effectiveness does not meet best practice standards due to a low performance of 2.2.  

Attenuation based stormwater management facilities scored an overall score of 1.8 on the multi-

criteria decision matrix due to the low performance in the cost effectiveness with a score of 1.The 

major contribution to the low score is the estimated BOQ exceeding R10 million. Retro-fitting 

solutions in a developed urban environment is a huge challenge for engineers and project managers 

whom are solving inherited problems, thus the underground concrete attenuation facility is a valid 

design alternative.  

The 30, 10 and 60 percent weighting of the environmental, social and cost effectiveness 

respectively, plays a pivotal role in the results of this study. The next chapter entails the conclusions 

and recommendations found in this study.  
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5. Chapter Five: Conclusion and Recommendations 

5.1 Introduction 

The purpose of the fifth chapter is to provide the conclusion and recommendations from this study 

and areas of research for the future. The purpose of this study was to determine the cost effectiveness 

of stormwater management systems and incorporate the environmental and social contribution of 

the stormwater management systems on the community. The stormwater design alternatives 

considered are the use of conventional stormwater management systems, SUDS and attenuation 

facilities based stormwater management. 

5.2 Summary of Findings 

The study contributed to the set objectives in the following manner. 

5.2.1 The Cost Implications of Stormwater Management Systems 

The first objective was to evaluate the cost effectiveness of three stormwater management 

alternatives namely, conventional stormwater management systems, Sustainable Urban Drainage 

Systems and attenuation facilities based stormwater management systems. The study revealed that 

SUDS was the most cost effective stormwater management design alternative. The utility of SUDS 

as a stormwater management system in South Africa is currently clouded by a lack of understanding 

of the benefits one could yield, although it is best practise internationally to implement green 

infrastructure instead of conventional stormwater management systems. The cost savings in 

providing green infrastructure which serves the same functionality yet uses less costs is an 

imperative highlight of the findings of this study.  

The multi-criteria decision matrix is a powerful instrument for the integration of varying dynamics. 

The operation of the multi-criteria decision matrix to weigh economic, environmental and social 

effectiveness objectively may be implemented by other project managers in the planning and 

decision making process.  

5.2.2 Unchartered Benefits of Environmental Consideration 

The second objective was to determine the environmental influence of each of the stormwater 

management systems. The most environmentally responsive design was the SUDS with a score of 

4.4. The study found that SUDS utilized natural materials for construction such as soil for berms 

and vegetation within swales. Furthermore, SUDS contributed the restoration of biodiversity within 

the system as opposed to destroying natural habitats for ecosystems to flourish. However, the 
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awareness of the positive externalities gained from green infrastructure as a means to sustainability 

is not apparent to local government enforcers. The alignment of designs to sustainable objectives 

and therefore policies and strategies which are in place are not implemented in the decision process 

used by project managers.  

Conventional stormwater management systems scored 2.2 when measuring the environmental 

effectiveness. The study found that the use of concrete as a predominant material did not impact 

positively on the environment. Furthermore, the system does not create an ecosystem nor restore it, 

thus it was deemed to not be aligned with the sustainable intentions.  

Conventional stormwater management are currently being implemented irrespective of the lack of 

environmental effectiveness due to the functionality and reputation. Pipe networks have been tried 

and tested thus the reliability is high.  The incorporation of green infrastructure to existing 

conventional pipe networks is a step towards the right direction.  

Attenuation based stormwater management systems scored 2.8. The environmental effectiveness of 

the attenuation based design was low due to the underground concrete storage, however it was 

balanced by the use of a gabion baskets attenuation facility. The preservation of biodiversity may 

be apparent in the gabion attenuation, thus the environmental performance was more sustainable 

than conventional systems. The study also established that the integration of attenuation facilities 

which also serve environmental requirements is of paramount importance towards reaching 

environmental policy goals and objectives.  

5.2.3 The Social Contribution of Stormwater Management Systems 

The final objective of the study was to determine the social contribution that the stormwater 

management systems would provide to the communities within the catchment. SUDS was the most 

responsive stormwater design with a scoring of 4 from a social perspective. The inclusion of a sports 

field which acts as a storage basin during floods allows for social activities to take place on the 

design premises. SUDS would contribute positively to the community, however to be certain of the 

improvement to social constructs would require public participation.  

The conventional stormwater management system was found to contribute positively to the manner 

in which people live and further contributed to removing social barriers. Although, the 

implementation of the conventional system as a part of service delivery would subconsciously 

improve the community’s sense of self due to years of neglect, proving of the removal of social 

constructs was deemed difficult.   
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The attenuation facilities design scored a 3.8 for social effectiveness. Attenuation facilities was 

deemed to positively impact on the culture and values of the community and would further remove 

social constructs such as deserving less service delivery due to the geographic location of being 

within a township.  

5.3 Recommendations 

The utility of a cost effectiveness analysis as a standard government project management tool would 

assist in alleviating budget constraints in a precarious economic climate. It is recommended that 

cost effectiveness analysis is employed as an objective means of making decisions on design 

alternatives. In addition, green infrastructure options must be mandatory to the alternatives 

considered in designs due to the provision of service delivery at a more cost effective rate. 

The utility of a multi-criteria decision matrix as a decision making technique and cost effectiveness 

incorporates the environmental and social effects of projects, therefore it is recommended that 

project managers and planners within local government institutions use it to assist in achieving more 

objective decisions on sustainable project implementation.  

The enforcement of green infrastructure projects has not gained moment within eThekwini 

Municipality, which is highly due to a lack of knowledge on the advantages and positive 

externalities retrieved from their implementation. Therefore it is recommended that project 

managers and designers of infrastructure attend courses to advance their understanding on green 

infrastructure.  

The utility of green infrastructure as a means to compliance with environmental policies aligns with 

the strategic objectives of the IDP (2017) and NEMA (1998), therefore the mandate must be 

cascaded down to project managers within local government spheres to ensure implementation. 

Consequently, it is recommended that a policy which stipulates that a percentage of the 

infrastructure development must be green would assist in reaching alignment with policies and 

strategies which are in place. Furthermore, the inclusion of the above objective in the Key 

Performance Indicators (KPI) of project managers would ensure a consequence for not complying 

with the strategic objectives set. In addition, the enforcement of Maintenance Management Plans 

(MMP) which govern the construction methodology in cognisance of the environment are 

paramount to the successful implementation of environmental legislation and compliance by local 

government officials.  
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The conclusion on social effectiveness was difficult to obtain without the engagement of the affected 

community. Therefore public participation and knowledge sharing of the functionality and potential 

impact of infrastructure developments is recommended prior to constructing infrastructure.  

5.4 Recommendations for Future Studies 

Future research should consider the inclusion of maintenance costs over the design life of the 

stormwater management systems as such costs may influence the cost effectiveness significantly. 

The frequency of the maintenance is dependent on the amount of pollution and blockages 

experienced by the system and the contingencies incorporated into the design, for example placing 

a net across the upstream to mitigate against the accumulation of debris entering the stormwater 

management system. This in turn is dependent on the education and public participation 

engagements with the communities within the catchment. SUDS are the most vulnerable to 

aesthetically displeasing visuals in the event of pollution of the stormwater management system.  

Isipingo Regeneration is a project within the EThekwini Municipality which incorporates the 

objectives of different departments towards a holistic design strategy and implementation thereof. 

Departments such as Town Planning, Stormwater, Transport, Disaster Management and 

Environment have established a committee under the Development Planning and Environmental 

Management unit, Deputy Head, Mr Musa Mbhele to mitigate the challenges faced by the Isipingo 

community. The project is inspired by the 10 October 2017 floods which devastated the Isipingo 

community. A climate change adaptation approach is being utilised using the Urban Design Lab 

(UDL) model and workshops, which took place from the 18th to 20th February 2019 across the city 

towards mitigating the contemporary challenges plaguing the area. Stormwater flood mitigation 

plans were thus integrated into the Town planning plans. Future research into the outcomes of the 

Isipingo Regeneration Project is recommended.  

An investigation into the amount of understanding project managers and designers have on green 

infrastructure and its importance towards reaching sustainable environment and climate change 

objectives is recommended. Furthermore, the filtration of environmental policies and the level of 

compliance and awareness by project managers may be researched.  

Water harvesting structures enable the reuse of water, which would contribute to the alleviation of 

droughts and promote sustainability within South Africa as a water scarce country. Further research 

is recommended for the possible applications of this green infrastructure to change the paradigm of 

treating stormwater as a nuisance but rather a valuable resource. 
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Appendix 3: PCSWMM Modelling Step by Step Guideline 

1. Capturing your Input Files for the Model 

The first step is to attend the PCSWMM workshop to introduce one to the software and the extent 

of its abilities, just as the author did from 11 to 13 September 2018 in Cape Town, at Radisson Blu 

Hotel conference room. The catchment area must then be delineated on ArcGIS to retrieve 

geographical information from the full extent of the project area and the services within it 

(PCSWMM, 2018).  

 

1. Open ArcGIS Map > Locate site by searching for the road name> delineate by switching on 

contours in the table of contents and following the extent of the catchment accordingly.  

2. Activate all layers which require consideration such as stormwater pipes, stormwater 

manholes, flood planes and sewer pipes.  

3. Right click feature from the table of contents on the Stormwater Manholes layer and 

make this the only selectable layer.  

4. Click on Select Features 

5. Click and drag on map to select desired extent of the feature 

6. Right click on feature from table of contents > Data > Export Data 

7. In the Export Data window select ‘Selected Features’ from drop down menu and select 

‘This layers source data’ for the co-ordinate system. Browse to save file in project folder 

> OK > No 

8. Click   to Clear Selected Features.  

9. Repeat steps 3 to 7 to export layers which are relevant to the projects for PCSWMM 

modelling (PCSWMM, 2018). 

 

2. Starting a New PCSWMM Project 

1. Start PCSWMM and click New Project menu under the File menu. 

2. In the New Project dialog, enter the name of your project (Conventional Stormwater System) 

3. Select Simulations Options and check the following under General & Dynamic Wave: 

- Infiltration model: Green-Ampt 

- Routing Method: Dynamic Wave 
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- Flow Units: CMS 

- Inertial Terms: Dampen 

- Normal Flow criterion: both 

- Force main equation: Hazen-Williams 

4. Edit the bottom left tabs of the screen as shown (PCSWMM, 2018).  

 

3. Importing Layers into PCSWMM 

1. Import the polygon layers exported from ArcGIS by opening PCSWMM and click Open Layer  

  > Browse > required files and import accordingly.   

2. Repeat for other polygon layers 

3. Click on File > Import > GIS/ CAD file formats 

4. Select layer in which to add specific features by clicking on the tabs in the Import data 

window  

** Manholes are referred to as Junctions and Pipes are referred to as Conduits on the software.  

5. Select the options under the Import Data window before browsing for the desired shapefile – 

browse for file (Stormwater_Manholes.shp) by clicking on the folder icon > open 

6. Match project attributes to imported shapefile attributes > Finish > No 

• Repeat for conduits 

• Turn on the street map or Bing map satellite on the bottom left to see where you are 

geographically (PCSWMM, 2018).  

 

4. Preparing Shapefile Extents 

The extent of the shapefiles imported from ArcGIS may contain additional features on the layer 

which are not required for the purpose of the simulation, thus one may delete them using the 

following step below:  

1. Click on the junctions feature first in the layers panel  

2. Make sure you are in select mode – hold down ctrl and left click on the mouse to draw a 

square over the area within which you wish to keep/delete items – notice they highlight 

in blue 

3. Alternatively, if the area you wish to delete is smaller than what you wish to keep then 
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simply press delete on the keyboard.  If the area you wish to delete is bigger, then at this 

stage click on the ‘Find’ icon > Invert selection > delete 

4. Repeat for conduits and other shapefiles accordingly (PCSWMM, 2018). 

 

5. Connectivity and Error Checking – Stage 1 

 

Now that you have all of the required network shapefiles, you want to check that there is 

connectivity between the junctions and conduits.  You also want to inspect that the information 

within the shapefiles is realistic.   

 

1. Cross check that there are no missing data in the network.  Do a visual inspection and 

comparison.  With the information available on ArcGIS.  

2. The first thing to check is that the dimensions of the imported shapefiles are correct.  

Select Conduits on the project panel and change the view to Table on the top of the screen.  

These columns represent the attributes allocated to conduits.  Notice the Geom1 column 

is set at meters.  Therefore the values in that column are incorrect.  To change the values 

to pipe diameters represented in m, use the following tip: 

o Open an excel sheet on the side.  In PCSWMM click on Geom1 to highlight the 

column.  Right click copy and paste into excel so that you can manipulate the data 

o Copy and paste it over the old data in PCSWMM 

3. Change to Map view.  Each service line requires an outfall.  Find the last junction along 

each line and convert it to an outfall by right clicking on the junction > Convert > Outfall.  

Notice the blue dot changed to a red triangle.  (Repeat for each line) 

4. To check that all conduits and junctions are connected to allow flow through them, click 

on any junction + hold down shift and click an upstream or downstream junction.  If the 

line is not interconnected an error message similar to the one below will appear – If so, 

move in smaller line lengths to find the error. 

5. You may also use the connectivity tool to find missing info 

6. To connect them, while still in the map view, click on Tools > Connectivity > Auto-

Connect.  A Click Analyze > Apply > Close 

7. Repeat step 4 to check that it has connected successfully. 

8. If there are unconnected nodes (junctions, outlets, outfalls) which we call ‘orphans’ the 

model won’t run 
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9. Change to Map view.  Click on Junctions 

10. Select Tools > Nodes > Select Orphans 

11. Select Current Layer only (Junctions) > Select (N.B if you want to apply to all you can 

however it is more thorough to go through each individually). 

12.  Repeat step 4 to check (PCSWMM, 2018). 

6. Adding Items to the Model 

This section will teach you how to add/delete items. Before moving on, let’s create a duplicate of 

the model by using the scenario tool. 

1. Click on the Scenario Manager icon   > Add > Duplicate current project  

2. Rename the copy as Conventional 2 and change description.  Browse to save 

the model in the same folder and click Create. 

3. You have now created the copy in the scenario manager window.  Double click 

Conventional 2 in the scenario manager to open the model (close reports that 

pop up) (PCSWMM, 2018). 

 

7. Add an Outfall Node 

The next step is to add physical model entities to the project in the Map view. First it's useful to 

start by adding an outfall node: 

1. As a general rule return to the Map view by clicking the Map view tab at the 

top of the screen. 

2. Click the Outfalls item in the Project panel and click Add     in the map 

panel.  Click on the map where you would like to place the outfall. 

3. Change to Select mode to stop the add mode.  Attributes can be changed in the 

Attributes panel on the right hand side (PCSWMM, 2018). 

• To move nodes select item on the map > click Move > drag arrow to new position > 

double click > change to Select mode to exit 
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8. Adding Conduits 

After the nodes are placed in the correct locations, the conduits can be inserted in a similar manner 

remembering to start from upstream to downstream: 

1. Click the Conduits item in the Project panel and click Add  

2. Click on upstream junction and then on the downstream junction to finish creating 

the conduit. The attributes can be changed in the Attributes panel on the right hand 

side. 

3. Change to Select mode to exit Add mode 

• Manhole spacing should be approximately every 50m and where there is a change in 

direction to allow for gradual bends (PCSWMM, 2018) 

 

9. Adding Sub-Catchments 

 

Now let’s delineate our sub-catchments (keep in mind that PCSWMM considers an average slope 

for the catchment area. Therefore if it includes vast differences in slope then further divide the 

catchment to get a refined answer for significant catchment areas): 

1. Click the Sub-catchment item in the Project panel and click Add  

2. Place vertices on the map (by clicking the desired location) to define the polygon shape for 

the sub-catchment. 

3. Click Select or press Enter to commit to sub-catchment created. 

4. Refer to Attributes panel for sub-catchment characteristics 

5. The area and width are usually set at default values.  Click on Tools   > 

Sub-catchments > Set area/length > close (PCSWMM, 2018). 

 

 

10. Delineating Sub-Catchments Using LIDAR 

 

This section will explain the use of LIDAR and how to read the data from the .flt files.  

 

1. Firstly, save your work in Conventional 2.  Open the 
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Conventional_Stormwater_Management System.inp model from the PCSWMM Prelim 

Course 2019> Conventional_Stormwater_Management System.inp.  (be sure to activate 

your Bing map on the bottom left). 

2. Click Open> Browse the PCSWMM dissertation folder.  

3. Select and open LIDAR.FLT.   

4. If you hover your mouse over the grey area, you will notice a z-value appear on the bottom 

of the screen.  Refer to the back of your manual for extra notes on LIDAR. 

5. To delineate sub-catchments, click on Tools > Sub-catchments > Watershed Delineation. 

6. Make sure the DEM layer is set to the correct file.  Change the Target discretization level to 

5 ha.   

7. Click Delineate watershed.  The program will now create sub-catchments as close to 5 ha as 

it can using the point elevations available in the DEM layer.  Text editor reports will pop up 

at the end giving you a summary of the action, click close. 

8. Notice there are flow paths that have been created in blue that are looking for valleys and 

carrying the flow to the nearest outlet.  In some cases the program would have created 

junctions to accept the flow.  This is where your engineering judgment comes in. 

9. We will assume you understand the site and the intricacies of the buildings etc.  The aim is 

to analyze the capacity of the stormwater network.  You need to identify which watersheds 

are flowing into which inlets in the network. 

10. If the sub-catchments are too large or too small you may use edit it by joining, splitting or 

simply editing the vertices.  To do this click on a sub-catchment and then right click > Edit 

> select the action you want.  For joining 2 or more sub-catchments, first highlight them by 

holding down control and right click > Edit > Join.  For this exercise you are welcome to try 

any action – we will be using another model to proceed. 

11. Once you are happy with the size and shape of your sub-catchments, you will have to edit 

the sub-catchment attributes for each by editing the properties in the attributes panel on the 

right of the screen.   

12. Make sure to set an outlet for each sub-catchment (it can be a node / another sub-catchment).  

13. If you are working with a large network and this process is too tedious then a quicker way 

is to use the Set Outlet tool (Tools> Sub-catchments > Set Outlet (PCSWMM, 2018). 
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11. Rendering  

This Section will show you the functionalities of the Render  tool.  This allows you to 

manipulate the map and table views.  The Properties tool in the Graph and Profile views have similar 

functions. 

 

1. Rendering Network : Select the layer to be rendered and click Render 

2. You will notice a window pop up (see below-Layer Properties).  This window 

allows you to change the shape color and labels you see on the display.  You may 

also play around with the opacity (transparency).  Apply changes and close. 

3. Rendering LIDAR:  You may edit the LIDAR to show different ranges of 

elevations by color.  While still in the Render tool > select LIDAR from the layer 

options. 

4. Notice that the window looks different.  Click on Levels.  This will open a Level 

Creator.   

5. Specify a min and max elevation depending the terrain data (you can find the min 

and max by hovering over the LIDAR 

6. The Levels indicate the no. of ranges created within the min and max values. 

7. You may change the color scale by changing the ‘Ramp’ simply by dropping 

down the arrow and clicking select > Create levels to apply changes.  

 

12. Checking your Model Setup – Stage 2 

The next step is to check the model entities and ensure there are no invalid data points. This is an 

iterative process as you will initially find the obvious missing information, correct it, and then 

when running a simulation, you may find more, and then correct again and so on until you are 

happy with the set-up. 

 

Here is an overview of some of the most common problems that occur when importing data from 

the GIS system: 

 

• Missing or incorrect junction inverts 
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Now that the lines are connected and can allow a flow through it, we need to check that the grades 

within the system are realistic – if it an existing system, scrutinize the reliability of the data and if t 

is a new system you are lucky enough to dictate your own slopes. 

 

1. Start with the Render plot, and select junction, then invert, make the font large, apply and 

do a visual inspection. 

2. Select all the junctions, and then switch to the Table view and inspect. 

3. Use the invert correction Tool correct. If you are uncertain, you can manually enter the 

invert and depth. Use the contours and junctions upstream and downstream to assume an 

invert. 

4. Highlight the line as you did in Step 4 – you may start from upstream-down or vice versa.   

5. Select Profile view at the top of the screen to view that lines profile.  Does the profile look ok to 

you?  You are looking for sudden spikes or dips in the profile. 

6. Repeat for all lines. 

 

• Conduits are linking in the wrong direction (upstream) 

 

1. Not a major problem. Flows may be shown as negative. Use the render plot to plot 

Junction total flooding. Or use the Simulation output file and find unusual flooding 

junctions. Re-enter the junction in and out in the attribute table once the conduit is 

selected. 

2. Use the analysis Tool function to check the system continuity. 

 

• Sub-catchments link to the incorrect junction. 

 

1. Use the Assign Junction to Sub-catchment Tool make sure every Sub-catchment has a 

link out. 

2. Use the lowest, middle function. 

3. If you are worried about this, you have to go through each Sub-catchment and check. 

where the little red flow line links up 

 

• Sub-catchment widths are incorrect and require individual inspection. 
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14. Simulating a Rainfall Data 

 

Now that we have a network setup, we need to introduce a flow to the network for the simulation 

to work.  To do this we need to create a Rain Gauge: 

 

1. On the top left of the GUI under Climatology there is a drop down.  Click this to 

collapse more options. 

2. Select Rain Gauges from the options to open the Rain gauge Editor. 

3. Click Add > Name your rain gauge.  Make sure to set the rain format to 

INTENSITY; Time Interval as 0:05 (minutes). 

4. Click Design Storm Creator > South Africa SCS (South Africa’s rainfall trends 

are similar to a Type 2 distribution so we usually use Type 2.  Change the name 

to match the rain gauge name.  Set the rain format as desired but keep this in mind 

when reading simulation results). 

5. The total rainfall is found using the same method you would have used to find 

your rainfall intensity for the Rational Method.  The only difference is you will be 

reading off values from the 1440 column.  

6. Select Create Rain Gauge.  

7. Check to see that all the information is correct before clicking OK. 

8. In the Map view, select a sub-catchment and Ctrl + A to select all sub-catchment 

9. In the Attributes panel go to Rain Gauge and click on the *.  Notice there is an 

option to select the new rain gauge you just created.  Selecting the rain gage will 

apply the same rainfall across all catchments > Save. 

 

15. Creating Rainfall Gauges for the Simulations 

• Real data for actual storms. 

 

It is very useful to run simulations with actual rainfall data. It provides an indirect way of 

calibrating the model by comparing outputs with observational data. 

6. Obtain a text file of the rainfall recorded in the region. 

7. Use Excel to create a continuous time series. The recorded data will only have a time 
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series for when it rains, you need to fill in the missing times steps using Excel tools like 

Vlookup etc. 

8. Create a new rain gauge in the PCSWMM rain gauge setup. Then add a new time series 

and copy and paste your actual rainfall into the time series. (Follow the steps explained in 

the previous section). 

 

16. Setting up and Running Simulations 

Once your rain gauges are set up, you will have to tell the program how you want it to run the 

data you have inputted. 

1. Click on the Simulation Options tab in the Project panel and ensure the general 

information is correct. 

2. Select the Dates tab and only input date for Start analysis on and duration. 

3. The rest of the information will change automatically. 

4. Now select Time Steps tab and input Reporting time. (Reporting time should be the same 

as the time series interval) > OK. 

• For real rainfall data: Be careful to ensure the simulation period matches that of the 

input time series (if dates are supplied in the time series). If rainfall or climate data are 

read from external files, then the simulation dates should be set to coincide with the 

dates recorded in these files. 

5. Click on Run  to run the simulation. The bottom right hand corner will report 

on the status of the run. 

6. If the simulation does not run successfully, look into the Status report section on 

Warnings to identify why.  

 

To see the profile and behaviour of the stormwater run-off through the system a profile was 

projected by pressing the profile tab as seen in Figure 1 below (PCSWMM, 2016).  



92 

 

 

Figure 1: Long Section of Conventional Stormwater System  

Source: PCSWMM, 2018. 

In the event of an error or overflowing of the stormwater management system, the model depicts 

the junctions that are not managing at a specific time as seen in Figure 2 below. 

 

Figure 2: Depiction of Flooding and Surcharge  
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Source: PCSWMM Model, 2018. 

The design can thus be altered and run again to ensure the surcharging and flooding points are 

removed from the system. The status tab shows the flow rates and checks required to validate the 

design. 

 

17. SUDS PCSWMM Model 

1. Click on the Scenario Manager icon   > Add > Duplicate current project.  

2. Rename the copy as SUDS and change description.  Browse to save the model in the same 

folder and click Create. 

3. You have now created the copy in the scenario manager window.  Double click SUDS in 

the scenario manager to open the model (close reports that pop up) (PCSWMM, 2018). 

4. Click on the conduits layer in PCSWMM and open the table to view all conduits and 

properties.  

5. Change the size and roughness coefficient to suit the properties of a swale instead of a 

concrete pipe. The swales are trapezoidal in shape with a 0.4 roughness coefficient. 

6. Run the simulation to see flow rates. Figure 3 shows the long section profile generated by 

PCSWMM.  
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Figure 3: SUDS Model on PCSWMM  

Source: generated from PCSWMM, 2018. 

 

18. Attenuation Based Facilities PCSWMM Model 

1. Click on the Scenario Manager icon   > Add > Duplicate Conventional 2. 

2. Rename the copy as Attenuation Based and change description.  Browse to save the 

model in the same folder and click Create. 

3. You have now created the copy in the scenario manager window.  Double click 

Attenuation Based in the scenario manager to open the model (close reports that pop 

up) (PCSWMM, 2018). 

4. Click on the storage layer on PCSWMM and add accordingly onto your network. 

5. Alternatively, you could convert an existing junction into a storage unit by clicking 

on convert> storage. 
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6. A rating curve is required to demarcate the size of the attenuation by pressing on the 

storage curve drop down and clicking on tabular. 

7. Press on curve name below and add the curve according to the depths and area to 

simulate the storage volume of your attenuation facility. 

8. Repeat steps 4 to 7 to add another attenuation where appropriate. 

9. Run the simulation to see the outcome. The profile shows attenuation ponds the same 

way it does manholes as seen in Figure 4. 

 

 

Figure 4: Attenuation Facilities PCSWMM Model  

Source: Author generated from PCSWMM 2018. 

 

  



96 

 

Appendix 4: Long section of Conventional Stormwater Management 

System  
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Appendix 5: Long Section of Sustainable Urban Drainage System  
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Appendix 6: Long Section of Attenuation Facilities Based System 
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Appendix 7: Long Section of Conventional Stormwater System  

 

Figure 5: Long Section of Conventional Stormwater System 

 Source: Author generated from PCSWMM, 2018.  
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Appendix 8: Depiction of Flood on PCSWMM Model 

 

Figure 6: Depiction of Flooding on PCSWMM Model  

Source: Author generated from PCSWMM, 2018. 
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Appendix 9: SUDS PCSWMM Model 

 

Figure 7: SUDS Model on PCSWMM  

Source: Author generated from PCSWMM, 2018. 
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Appendix 10: Attenuation Facilities PCSMM Model 

 

Figure 8: Attenuation Facilities PCSWMM Model  

Source: Author generated from PCSWMM, 2018. 
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Appendix 11: Ethical Clearance 
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Appendix 12: Turn it in Report 
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Appendix 13: Gate Keepers Permission Letter 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 






